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Copyright Statement:

The ownership of the User Manual belongs to ANKON Technologies Co., Ltd., and it should not be
distributed or reproduced by any means or in any form without prior written permission by
ANKON Technologies Co., Ltd.. The User Manual is protected by copyright, and all rights are
reserved. ANKON Technologies Co., Ltd. reserves the right to change the User Manual and the
products as described herein. Equipment specifications are subject to change without prior
notification. Any information contained in the User Manual is not to be considered a proposal,
guarantee, commitment or contractual conditions.

Warranty

ANKON Technologies Co., Ltd. assures that all parts in the NaviCam Small Bowel Capsule
Endoscopy System are well-designed, manufactured, packed and tested for prevention of defects,
and assumes no responsibility for any accident, loss, damage or cost increase directly or
indirectly resulting from use of the ESView platform. ANKON Technologies Co., Ltd. will repair

or replace parts within the warranty period, while customer is responsible for all other items
including normal wear and team or anything that is out of the control of ANKON Technologies
Co., Ltd., including but not limited to operation, storage, cleaning, misuse, abuse, patient
treatment or diagnosis. This warranty replaces any other warranties which may have been
implied in verbal or documented form.

Modifications by User or Third Party
Any and all modifications to the product which are not expressly approved in writing by
ANKON Technologies Co., Ltd. will void this warranty in its entirety.

Manufacturer: ANKON Technologies Co., Ltd.
Address:B3-2,B3-3,D3-4 Biolake,No.666,Hi-Tech Road, East Lake New Technology
Development Zone, Wuhan, 430075 Hubei, China

CAUTION:
US Federal law restricts this device to sale by or on the order of a physician.
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CHAPTER 1: INTRODUCTION

1.1 Important Information

A thorough understanding of the technical principles, clinical applications and risks associated
with the NaviCam Small Bowel Capsule Endoscopy System is necessary before using this product.
Read this entire manual before using the system for the first time.

CAUTION
A ® Failure to follow instructions could result in damage to the
equipment or pollution to environment.

WARNING
A ® Failure to follow instructions could result in injury or even death
to operator; patient, or other personnel.
® To avoid the risk of electric shock, this equipment must only be
connected to a power supply that is properly grounded.

1.2 About NaviCam Small Bowel Capsule Endoscopy System

The User Manual introduces the use of NaviCam Small Bowel Capsule Endoscopy System (Model:
NS-I, hereinafter referred to as "NaviCam SB System"). The NaviCam SB System is a type of
capsule endoscope system. This chapter introduces tip information involved in the quick guide
and the User Manual.

NaviCam SB System is comprised from the following components:
- Capsule (Model: AKES-11SW, AKES-SI)
- Data Recorder (Model: AKR-1, AKRI-1)
- Locator (Model: AKS-1)
-ESView Software

The NaviCam SB System contains two components, the Capsule and the Data Recorder, which
work in different frequencies - 2.4GHz, 915MHz. These components are equally used in
conjunction with the other components of the NaviCam SB System, namely, the Locator and the
ESView software. The relationship between the models of the Capsules and the models of the
Data Recorders with their corresponding frequencies is shown in Table1-1.

CAUTION
A ® Mixing between the Capsule model and Data Recorder model will result

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1
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in a failed examination and could damage the equipment.

Table1-1: Relationship between product models and associated frequencies

Frequency Capsule Model Data Recorder Model
2.4GHz AKES-11SW AKR-1
915MHz AKES-11SI AKRI-1

A description of each component is provided below.

1.2.1 Capsule(AKES-11SW/AKES-11SI)

The Capsule presented in Figure 1-1, is a capsule endoscope capable of capturing images inside
the human digestive tract. This capsule contains a built-in camera, wireless receiving and
transmitting unit, LED lights, battery, and a magnet. All components are sealed in a case made of
biocompatible materials.

Figure 1-1: Capsule (2.4 GHz AKES-11SW, 915MHz AKES-11S5I)

WARNING
A ® Capsule is MR unsafe.

Note: This equipment has been tested and found to comply with the limits for a Class B digital

device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates
uses and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

—Reorient or relocate the receivingantenna.
—Increase the separation between the equipment and receiver.

—Connect the equipment into an outlet on a circuit different from that to which the receiver

isconnected.

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1
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—Consult the dealer or an experienced radio/TV technician forhelp.

1.2.2 Data Recorder
1.2.2.1 Data Recorder (AKR-1)

The AKR-1 Data Recorder, presented in Figure 1-2, is a portable data receiving unit with built-in
rechargeable lithium battery placed inside the examination cloth worn by the patient during
examination. It is used for receiving image data wirelessly transmitted from the Capsule.

The Data Recorder is charged with an included charger when not in use.

A

Figure 1-2: Data Recorder (2.4 GHz AKR-1)

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in
a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

—Reorient or relocate the receiving antenna.

—Increase the separation between the equipment and receiver.

—~Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

—~Consult the dealer or an experienced radio/TV technician for help.

WARNING
A ® Never charge the Data Recorder when it is in use by a patient.

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1



NaviCam Small Bowel Capsule Endoscopy System User Manual P:

e |8

)
()]

Note:

The Data Recorder is used in a hospital environment.as well as in the home
healthcare environment, and shall be used by trained personnel or professional
personnel.

The service life of the battery under the typical condition is 5 years.

For the Data Record at low-temperature storage ,which is beyond the operating
temperature range, please place them for half an hour or more until warm to
operating ambient temperature before using them. And also, for the Data Record at
high temperature storage ,which is beyond the operating temperature range, please
place them for half an hour or more until cool to operating ambient temperature
before using them.

1.2.2.2 Data Recorder (AKRI-1)

The AKRI-1 Data Recorder works in the same way as Data Recorder (AKR-1). The AKRI-1 Data
Recorder consists of the following three parts as shown in Figure 1- 3

1) Data Recorder Host.

2) Belt-examining cloth (including antenna) and data cable.

3) Charging base.

Figure 1- 3 Data Recorder (915MHz AKRI-1)

The Data Recorder is charged with an included charger when not in use.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in
a particular installation. If this equipment does cause harmful interference to radio or television

reception, which can be determined by turning the equipment off and on, the user is encouraged to try to

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1
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correct the interference by one or more of the following measures:

—Reorient or relocate the receiving antenna.

—Increase the separation between the equipment and receiver.

—~Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

—Consult the dealer or an experienced radio/TV technician for help.

WARNING
A ® Do not charge the Data Recorder when it is in use.

® The battery of the Data Recorder is non-removable and the users
shall not replace the battery at discretion.

Note:

® The Data Recorder is used in a hospital environment.as well as in the home
healthcare environment, and shall be used by trained personnel or professional
personnel.

® The service life of the battery under the typical condition is 5 years.

® For the Data Record at low-temperature storage ,which is beyond the operating
temperature range, please place them for half an hour or more until warm to
operating ambient temperature before using them. And also, for the Data Record at
high temperature storage ,which is beyond the operating temperature range, please
place them for half an hour or more until cool to operating ambient temperature
before using them.

1.2.3 Locator

The Locator, presented in Figure 1-4, is a portable magnetic scanning device with built-in
rechargeable lithium battery. It is used to turn the capsule on before it is swallowed by the
patient and can be used for detecting whether a capsule is inside the human body and
probing its approximate position.

The Locator is charged with an included charger.

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1
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Figure 1- 4: Locator
WARNING
® Never charge the Locator when it is in use by a patient.
® For patient who needs to undergo an MRI test before the expulsion
of the capsule has been confirmed, Locator scan should not replace
an X-Ray to confirm the absence of capsule in the body.

1.2.4 ESView Software

ESView software is the image review software component of the NaviCam SB System . It
can be installed on a dedicated image review computer at a hospital, clinic, or doctor’s
office for physicians to review capsule endoscopeimages.

The ESView enables the following functions:

Patient check-in

Data export

Image browsing, processing, and editing, with or without the optional ProScan feature
Report generation

Case management

Capsule endoscopy atlas

The minimum operating environment for running ESView software is asfollows:

CPU: Intel Core i3 2.0GHz or later
GPU:rtx4000 or later

Monitor: Resolution 1920*1080 or higher
HDD: 250GB or above

Memory: 8GB or above

USB Port: 2 or more

Operating System: Windows 7 or above

1.3 Summary of Clinical Performance

The NaviCam Small Bowel Capsule Endoscopy System was evaluated in two clinical studies: (1) a
prospective study, comparing its performance to that of the FDA cleared PillCam SB3 Capsule
Endoscopy System (hereafter referred to as “PillCam SB System”); and (2) a retrospective study
to evaluate the performance of the optional ProScan feature of the ESView software. Summaries
of both studies are provided below, and the full reports are attached to Section 20.

(1) “Performance Evaluation of the AKE-1(NaviCam SB) Capsule Endoscope System in
Comparison to the PillCam SB3 Capsule System for the Diagnosis of Small Bowel Diseases”
This was a prospective, comparative study in 3 sites in China, aimed to evaluate the performance
of the NaviCam SB System (trial capsule) when compared to the PillCam SB System (control

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1
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capsule or comparator) for the diagnosis of small bowel diseases.

Study primary endpoints included Per Findings analysis, where the recordings obtained with
both capsules were independently evaluated and the agreement between findings of both
capsules was evaluated; and, Per Subject analysis; where the diagnosis of subjects based on
independent interpretation of images obtained with both capsules was evaluated (diagnosis of
normal or abnormal per subject). A number of secondary endpoints were also assessed
including ease of swallowing the capsule, intestinal transit time, capsule excretion time,
diagnostic yield when compared to other standard mucosal imaging procedures, quality of small
bowel images, image reading time, and agreement between two or more reviewers with respect
to interpretation of the images obtained.

The study included adult subjects with symptoms of small bowel diseases or suspected
gastrointestinal bleeding. After signing informed consent, subjects who met the study eligibility
criteria completed gastrointestinal preparation in advance according to the examination
schedule. Before swallowing the capsules, an antifoaming agent (10ml simethicone) with 120ml
of water was administered to reduce air bubble formation in the small bowel. Each subject wore
the two types of data recorders then swallowed the two types of small bowel capsules
approximately 40 minutes apart in a randomized order. Subjects were allowed to drink water 2
hours after swallowing the capsules and eat a small amount of food 4 hours after swallowing the
capsules. Upon confirming that the capsules have entered the small bowel, the subjects left the
hospital and were instructed to continue wearing the data recorders for 8-10 hours until the
power of the capsules were depleted, or the capsules were excreted.

The anonymized images acquired by both the trial capsule and comparator were read by two
gastroenterologists independently for normal and abnormal interpretation and analysis of lesion
type (edema, polyp, hemorrhage, etc.), capsule transit time, reading time and image quality; in
cases of disagreement, a third gastroenterologist reviewed the video in question and provided
his/her result.

A total of 97 subjects were enrolled in the study; 10 subjects were withdrawn or withdrew
consent prior to the study procedure. As these subjects did not swallow the capsules, they were
excluded from data analysis, therefore, the results from 87 subjects were included in both Per
Protocol Set (PPS) analysis and Full Analysis Set (FAS).

Primary Efficacy Results:
Per Subject Analysis: Normal versus Abnormal

Abnormal rates (NaviCam 73/87 - PillCam 68/87) 83.91% - 78.16%,
Positive Percent Agreement (PPA) [95% CI]: 97.06% (89.90%, 99.19%)
Negative Percent Agreement (NPA) [95%CI] 63.16% (41.04%, 80.85%)
Overall Percent Agreement [95% CI] 89.66% (81.50%, 94.46%)
Overall percent agreement per Kappa analysis [95% CI] | 0.6652 (0.4653, 0.8652)
Positive Predictive Value (PPV) [95% CI] 90.41% (81.50%, 95.28%)
Negative Predictive Value (NPV) [95% CI] 85.71% (60.06%, 95.99%)
McNemar Test Results X2=2.7778, p=0.0956

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1
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Per Finding Analysis:

There were no statistically significant differences between the 2 capsules in the detection of
vascular lesions (p=0.2087), inflammatory lesions (p=0.6831), tumors/polyps/masses
(p=1.0000), ulcers/ulcerations (p=0.3938), and other lesions (p=0.4669).

Safety Results:

One case of capsule retention occurred where both NaviCam and PillCam capsules were retained.
The incidence of adverse events was 1.15%. No abdominal pain, abdominal distention, nausea,
vomiting, headache, obstruction, or other adverse events occurred.

In conclusion, the NaviCam SB System and PillCam SB System had a diagnostic overall percent
agreement rate of 89.66% (81.50%, 94.46%), and an overall percent agreement Kappa of 0.6652
(0.4653, 0.8652). The results of this comparative study indicate that NaviCam Small Bowel
Capsule Endoscopy System performs similarly to the PillCam SB3 Capsule Endoscopy System
and provides an effective non-invasive method for the detection of small bowel diseases.

(2) Retrospective Evaluation to Compare Small Bowel Video Reading by AKE-1 (NaviCam
SB) Capsule Endoscopy System with ProScan Feature and PillCam SB3 Capsule System
with SBI Feature”

The goal of this retrospective evaluation was to compare the performance of the NaviCam SB
System ESView software with the ProScan feature to this of the PillCam SB System with the SBI
feature. The recordings/images used in this study were previously obtained in the prospective
study (study (1)) and were analyzed by two independent reviewers for visual comparison of the
findings and analysis using ESView software with ProScan and Rapid software with SBI in
comparison to the conventional reading previously performed for both systems.

Capsule endoscopy videos of 87 subjects were used and included in both the Full Analysis Set
(FAS) and Per Protocol Set (PPS) analyses.

The primary endpoint of the study was to evaluate the performance of the NaviCam SB System
with the ProScan software feature in comparison with the PillCam SB System SBI feature (per
patient analysis). Secondary study endpoints included per findings analysis, image review time,
and image review time of NaviCam reading with and without the ProScan feature on.

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1
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Per Subject Analysis: Normal versus Abnormal

Abnormal rates (NaviCam 84/87 - PillCam 81/87) 96.55% - 93.10%,

Positive Percent Agreement (PPA) [95% CI]: 100.00% (95.47%, 100.00%)
Negative Percent Agreement (NPA) [95%CI] 50.00% (18.76%, 81.24%)
Overall Percent Agreement [95% CI] 96.55% (90.35%, 98.82%)
Overall percent agreement per Kappa analysis [95% CI] | 0.6506 (0.2866, 1.0000)
Positive Predictive Value (PPV) [95% CI] 96.43% (90.02%, 98.78%)
Negative Predictive Value (NPV) [95% CI] 100.00% (43.84%, 10.00%
McNemar Test Results X2=3.0000, p=0.0833

These results demonstrate that the NaviCam SB System and PillCam SB System have good
diagnostic consistency.

There were no statistically significant differences in the diagnosis of vascular lesions (p=0.4497),
inflammatory lesions (p=0.3173, tumors/polyps/masses (p=0.2207), malabsorption (p=1.0000),
ulcers/ulcerations (p=0.7963), and other lesions (p=0.0863) between the NaviCam SB and
PillCam SB systems.

The video review time of the trial capsule was 1.63 min higher than that of the control capsule,
and the difference was statistically significant. The difference between the mean reading time of
the NaviCam SB with ProScan on and conventional reading (i.e., without ProScan feature on) was
-36.63 min (-46.29 min, -26.72 min) (95% CI), the difference was statistically significant. The
results of the analysis of the consistency of the interpretation of the images obtained by two or
more reviewers (FAS/PPS) show that the differences between the two groups are not
statistically significant.

The results of this study showed that the clinical performance of the NaviCam SB System with
the ProScan feature and PillCam SB System (with SBI) were similar, and that the NaviCam SB
System with ProScan feature on significantly reduced the physician's reading time compared to
the reading time of the NaviCam SB System without the ProScan on (21.47+8.05 vs. 58.10+45.28,
p<0.0001).
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CHAPTER 2: INDICATIONS, CONTRAINDICATIONS AND WARNINGS

2.1 Indications

The NaviCam Small Bowel Capsule Endoscopy System is intended for visualization of the small

bowel mucosa in adults. It may be used as a tool in the detection of abnormalities of the small
bowel.

2.2 Contraindications

The capsules are contraindicated for use under the following conditions:
e In patients with known or suspected gastrointestinal obstruction, strictures, or fistulas
based on the clinical picture or pre-procedure testing and profile.
e In patients with cardiac pacemakers or other implantable electronic medical device.
e In patients with an easily magnetized metal part.
e In patients with dysphagia or other swallowing disorders.
e Inpregnant women.

Note: The Capsule maybe deployed by using transendoscopic delivery in patients who are
unable to ingest the capsule or are known to have prolonged gastric emptying time.
Placement into the duodenum is recommended to prevent the patient from vomiting the
capsule.

2.3 Adverse Events

Potential adverse events associated with the use of a capsule include injury to a patient caused
by delayed excreting or not excreting of capsule, aspiration of the capsule, and interference from
strong magnetic field sources. It could be necessary to remove the capsule by intervention.

2.4 Warnings

A A negative or normal result obtained by the capsule does not exclude the presence of
pathology and if symptoms persist, further evaluation should be performed.

A If intestinal fistulas, strictures, or stenosis are suspected, or the patient has had prior
abdominal or pelvic surgery, the physician should consider performing an examination to
ascertain patency for an object the size of the capsule.

A The safety of the capsule has not been established in children.

A The capsule should not be swallowed by patients where a concern for aspiration of the
capsule exists (e.g., due to cognitive or neurological deficits or a history of aspiration). In
these patients, it is recommended that a capsule endoscopic delivery system be used to
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place the capsule directly in the duodenum. Placement of the capsule in the duodenum will
decrease the risk of aspiration of the device [by vomiting] and gastric retention.

A thorough understanding of the technical principles, clinical applications and risks
associated with the Capsule System is necessary before using this product. Read the entire
manual before using the system for the first time.

Make sure that only trained personnel or professional personnel, familiar with all operating
procedures of the NaviCam SB System, use the system.

To prevent the patient from being exposed to unforeseen risks during passage of any
capsule, make sure the patient thoroughly understands the procedure, and provide the
patient with a copy of the Patient Labeling.

A patient with known or suspected delayed gastric emptying (whether disease related or
drug induced) could be at increased risk for incomplete the NaviCam SB System.

When swallowing the capsule there is a possibility of choking on the capsule. If the patient
exhibits any symptoms and/or clinical signs of choking (labored breathing, wheezing,
involuntary coughing, etc.), the recommended first-aid procedure should be followed.
Keep the capsule away from implants such as pacemakers and other devices that could be
affected by proximity to a DC magnetic field.

If a child has accidentally swallowed any unused or spent capsule, seek medical attention.
Instruct the patient not to sit on bare metal surfaces, such as chairs with metal seating area,
during the procedure.

Instruct the patient to contact the physician immediately if, after ingesting any capsule,
there is any abdominal pain, nausea, or vomiting.

Only one capsule should be ingested at a time and only after confirmation that no other
capsules or ingestible diagnostic devices remain in the patient’s body.

If, contrary to instructions, a patient ingests more than one capsule, instruct the patient to
immediately contact the physician.

In patients with unsuspected strictures of the GI tract, any capsule can potentially cause
intestinal obstruction resulting in the need for hospitalization and surgery.

The safety of this device in patients with significant gastrointestinal diverticular disease is
unknown.

Final diagnosis based on the capsule images should be made only by physicians who are
trained in the interpretation of capsule endoscopy images.

[f there is reasonable doubt concerning the integrity of the capsule due to dropping, biting,
or any other eventuality, the capsule should be deactivated by returning it to its box and it
should not be used until consulting with an authorized ANKON Technologies representative.
Store all capsules in a safe place, out of the reach of children and infants.

Do not use any capsule after its expiration date.

Instruct the patient to avoid biting the capsule prior to swallowing.

Instruct the patient to wear the data recorder throughout the procedure.

After ingesting the capsule and until it is excreted, the patient should not be near any source
of powerful electromagnetic fields such as one created near an MRI device.
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Undergoing an MRI while the capsule is inside the patient's body may result in serious
damage to his/her intestinal tract or abdominal cavity. If the patient did not positively verify
the excretion of any capsule from his/her body, he/she should contact the physician for
evaluation with the Locator and possible abdominal X-ray before undergoing an MRI
examination.

A capsule should be ingested only in the presence of authorized medical personnel. The
patient should be instructed not to let relatives, neighbors or acquaintances use any
capsule without medical attention.

If excretion of the capsule from the patient has not been positively verified, and the patient
develops unexplained post-procedure abdominal pain, vomiting, or other symptoms of
obstruction, he/she should contact the physician for evaluation with the Locator and
possible abdominal X-ray examination.

Use the system only with components purchased from ANKON Technologies. Use of other
components may damage the system and void the warranty.

In a small number of cases, the capsules may not image the entire small bowel due to
variations in patient GI motility.

After ingesting the capsule, the patient should abstain from eating or drinking for another 2
hours. After 2 hours, the patient may drink water. After 4 hours, the patient may have a light
snack. After the examination is completed, the patient may return to a normal diet. These
instructions related to eating apply unless physician instructs otherwise.

The inspection will last for about 8 hours. The physician should instruct the patient when
the examination is considered complete. During the examination, the patient should avoid
any physical activity that involves sweating and to abstain from bending. The Data Recorder
should be treated with utmost care and protection. Sudden movement and banging of the
Data Recorder should be avoided. The patient should be instructed not to remove the Data
Recorder during the examination.

The patient may take his/her usual prescribed medication up until two hours before the
examination and resume two hours after capsule ingestion, with water.

If the patient is taking any medication that may delay gastric emptying, consider
withholding the drug on the day of the test if this is medically acceptable.

The capsule is for single use only.

Even if other devices meet corresponding national emission standards, the system may still
be interfered.

The battery of the Data Recorder is not removable, and incorrect replacement will lead to
unacceptable risks. Unauthorized personnel are prohibited to replace the lithium battery in
the equipment.

The users shall not disassembled/modified the Vest/Examination cloth as well as any
connection cable by themselves
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CHAPTER 3: ESVIEW SOFTWARE OPERATION INITIATION

3.1 Installation

1. Double click the ESView software installer to install ESView software. The welcome dialog
box will pop up (Figure 3-1). Click “Next” to continue.
y FiNipw 1.7 Sebup = E
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Figure 3-1: ESView Installation Welcome Dialog Box

2. The Software License Agreement dialog box (Figure 3-2) is displayed. Scroll down to view
the agreement in its entirety. Click “I Agree” to accept.
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Figure 3-2: Software License Agreement Dialog Box

3. The dialog box for selecting the destination folder (Figure 3-3) is displayed. The default
installation directory is C:\Program Files(x86)\ESView. Click “Browse” to change the
directory. Click “Install” to continue installation in the selected directory.
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Figure 3-3: Selection of Installation Directory

4. The dialog box, showing the installation progress (Figure 3-4), is displayed.
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Figure 3-4: Installation Progress Dialog Box

5. After ESView software is successfully installed, the “Setup Completed!” dialog box (Figure

3-5) appears. Click “Finish” to complete installation. A shortcut to the ESView program is
created on the desktop.
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Figure 3-5: Successful Installation Dialog Box
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3.2 Uninstallation

1. To uninstall the ESView software, from the Windows Start menu, select “Programs”->
“ESView "> “Uninstall ESView”. The uninstallation dialog box (Figure 3-6) appears. Click
“Uninstall” to begin the uninstallation.
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Cbtusrvase, Chok Linenstadl bo start the uninstalation.
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Figure 3-6: Uninstallation Dialog Box

2. After ESView software is successfully uninstalled, the “Uninstall Success!” dialog box (Figure
3-7) appears. Click “Finish” to complete uninstallation.
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Figure 3-7: Successful Uninstallation Dialog Box

3.3 Basic Software Operation

1. Connect the data recorder to the PC installed with the ESView software, open the ESView
and create a new case, and enter and save the basic information of the patient in the data
recorder.

2. After confirming the patient information, turn on the capsule, and the images the capsule is
capturing and displayed on the Rtdisplay interface. Check if the capsule image display is
normal and if the capsule voltage meets the examination requirements. After confirmation,
operate according to the examination manual, and help the patient swallow the capsule.

3. After the examination is complete, connect the data recorder to ESView software and export
the image data from the recorder and generate a report after viewing the images.

The chart below (Figure 3-8) shows the workflow of the system.

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1



NaviCam Small Bowel Capsule Endoscopy System User Manual Page |22

Examination Begins
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Several cases
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Figure 3-8: NaviCam SB System Workflow

3.4 Software Startup

ESView software can be launched by double clicking the ESView shortcut icon on the desktop.
The ESView software launch screen (Figure 3-9) will appear.

rd SMHON

mmiesiam SE P EE i Fe

ESView 2.2

Figure 3-9: ESView Software Launch Screen

3.4.1 First-time Startup

When ESView software is launched for the first time on the computer it is installed on, the user
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needs to complete a registration step, using the unique license code received from ANKON, and
set up a software password.

1. At first-time launch of ESView software, the registration interface (Figure 3-10) is displayed.

The serial number in the top box automatically appears and the user has to enter the license
code received from ANKON into the blank box to register the software.

Note: ESView software will not function until registration is completed.

Figure 3-10: Registration Interface

2. After registration, the user is presented with an Ul to set up a login password for ESView
software. The user can choose to require the password to be manually entered every time

ESView software is launched or have the software automatically fill in the password, i.e.,
auto login.

Note: After logging into the main software interface, the user can select “Tools”> “Accounts”
in the menu to add/delete accounts and change passwords.

3. The user can then proceed to use ESView software.

3.4.2 Regular Startup

1. Use your login credentials to enter into ESView.Figure 3-11
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Figure 3-11: Login

2. If Microsoft Word 2003 or later version is not installed on the computer, ESView will display
a dialog box to alert the user that report generation in Word format will not be supported
(Figure 3-12).

Figure 3-12: Dialog Box Alerting that Word Format Report Is Not Supported

Note: All other functions of ESView software will not be affected.
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CHAPTER 4: ESVIEW SOFTWARE OPERATION INSTRUCTIONS

The main ESView software interface, where the user can browse and annotate images, is shown
in Figure 4-1. The user can also use the menu or buttons to access interfaces for patient check-in,
data export, medical record management, and report generation, etc.

o

e s ] e e e S

Figure 4-1: Main ESView Software Interface
4.1 Patient Check-in

In the main software interface, select “Tool” 2> “Check-in” in the menu to launch the patient
check-in interface (Figure 4-2), where the user can enter patient information and save it to the
data recorder. Eventually the patient information will be exported together with the patient
image data from the data recorder to the computer. The data recorder should be connected to
the computer via USB before patient check-in. Only one patient information can be saved in the
data recorder at a time.
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Figure 4-2: Patient Check-in Interface

The patient information already stored in the data recorder can be retrieved and displayed in the
information entry area by clicking the “Read record” button. The “Clear” button can be used to
clear patient information in the entry area. After entering the patient information, click “OK”
button to save the patient information to the data recorder, or click “Cancel” button to exit the
patient check-in interface without saving.

4.2 Real Time Viewing in Rtdisplay Interface
4.2.1 Access Rtdisplay

1. Inthe main software interface, select “Tool” > “Rtdisplay” in the menu to launch the
real-time display interface as shown in Figure 4-3.
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Figure 4-3: Rtdisplay Interface
2. Inthe Rtdisplay interface, images captured by the capsule endoscope inside the digestive
tract can be real-time displayed and its running status can be adjusted. The Data Recorder
should be connected to your computer via USB for Rtdisplay. If the Data Recorder is not
properly connected, buttons on the toolbar area are disabled, and "Connection to data
recorder failed" in red will be shown at the connection status display area on the status bar.

3. Ifthe Data Recorder is correctly connected, buttons on the toolbar are available, and
"Connected to data recorder " in black will be shown at the connection status display area
on the status bar.

4.2.2 Functions of Buttons in the Toolbar

The functions of the toolbar buttons are detailed in Table 4-1 below.
Table 4-1: Rtdisplay View Button Function
Icon Function

Shut down Data Recorder

Shut down capsule endoscope

Pause capsule endoscope
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4.2.3 Rtdisplay Image Zoom-in and Out

1. Image zoom-in and out can be realized by mouse scrolling, then scaled to x% will be
displayed in upper right corner of the image to represent current scaling factor, as shown in
Figure 4-4.

Figure 4-4: Zoom Function
2. To restore original size of the displayed image without any zoom in or out, double click the
image display area.

4.2.4 Data Recorder Status Indicator

1. Two LED status indicators are located in the lower right bottom of the Data Recorder. The
left one indicates work status (Green)m, and the right one indicates warning (red)

2. Meaning of status indicators:
a) Green LED flashes, red LED does not light - indicates image data from capsule
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endoscope has been received.

b) Green LED does not light, red LED lights - indicates no signal from capsule endoscope
has been received.

c) Green LED does not light, red LED flashes - indicates capsule endoscope signal has been
received, but no image data has been received.

4.3 DataExport

1.

In the main software interface, select “Tool”> "Data export” in the menu to access the data
export interface (Figure 4-5)

Figure 4-5: Data Export Interface

The data export interface is mainly used to export image data captured by the capsule
endoscope to the computer. This interface supports two export modes. One is quick export,
which exports the data as a raw data file with suffix *.ankon. *.ankon files cannot be opened
by ESView until being parsed to video files. The quick export mode is applicable when it is
needed to export image data of the last patient quickly and prepare the data recorder for the
next examination. The other export mode is direct export, which exports and parses the data
as a video file that can be opened by ESView software.

To use the direct export mode, select “Export and convert data into video file” and click
“Start export”. The image data will be exported from the data recorder as a video file that
can be directly opened by ESView.

To use the quick export mode, select “Export data as RAW file” and click “Start export”. The
image data will be exported from the data recorder as a raw data file with suffix *.ankon. To
convert raw data file to video file, select “Convert existing RAW file into video files” and click
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“Start export”, then select a RAW file in the raw data file selection interface (Figure 4-6) and
generate the video file.
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Figure 4-6: RAW Data File Selection Interface

5. The data recorder should be connected to the computer via USB when exporting data,
otherwise, an alert will appear on the data export interface to remind the user to connect
the data recorder to the computer (Figure 4-7).

Figure 4-7: Data Recorder Not Connected Alert

6. If “Shutdown computer when finishing” is checked, the computer will automatically shut
down after data export finishes.
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4.4 Image Browsing, Processing, and Editing, ProScan mode

4.4.1 Open Video

1. Inthe main software interface, select “File”>“Open video” to access the patient data file
selection interface (Figure 4-8). The default path is the data export path.

5 v i b -

Figure 4-8: Patient Data File Selection Interface

2. Select a patient folder and open the *.acpi file under the folder. The software will
automatically load image data in this folder, and the image data will be displayed in the main
software interface (Figure 4-9).
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Figure 4-9: Main Software Interface After Opening Image Data

3. To open recently opened videos, select “File”> Recent video”—> select video path” in the
menu.
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4.4.2 Video Playback Function

1. Inthe main software interface, click the forward or backward playback button (Figure 4-10)
to play the loaded video in forward or backward direction.

Figure 4-10: Video Playback Buttons

2. To stop video playback, click the pause button (Figure 4-11).
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Figure 4-11: Pause Playback Button

4.4.3 Image Browsing

1. Click the E‘J,m,@,m,andm buttons to access single-image display mode, two-image
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display mode, transverse four-image display mode, array four-image display mode, and
multi-image display mode, respectively, as shown in Figures 4-12 to 4-16. The display mode
can also be switched by selecting a display mode in the “Display” menu.
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Figure 4-12: Single-Im

age Display Mode
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Figure 4-13: Two-Image Display Mode
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igure 4-14: Transverse Four-Image Display Mode
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Figure 4-15: Array Four-Image Display Mode
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2. Use the playback speed slider = to adjust the video playback speed.

Click ﬁ to play video in forward direction. Click ﬁ to play video in backward direction.
Click ﬁ to display the next image frame. Click ﬁ to display the previous image frame.
Click ﬁ to display the last image frame. Click ﬁ to display the first image frame.

3. Insingle-image and two-image display mode, click @ to enlarge image display, and click
to shrink the image display. In other display modes, the enlargement function is

unavailable. In such case, click @ to switch to the single-image display mode. Figure 4-17

shows the single-image enlargement mode and Figure 4-18 shows two-image enlargement
mode.
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Figure 4-17: Single-Image Enlargement Mode
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Figure 4-18: Two-Image Enlargement Mode

4. Click E to access the image processing control panel, as shown in Figure 4-19. Drag the

corresponding sliders to adjust definition, brightness, and color. Checking the “Saturation”
box and then drag the sliders below to adjust saturation. The image can also be processed
using the software's built-in algorithms, including denoise, distortion correction, and image
enhancement. It is important to note that if any one of the four options (Image denoise,
Distortion correction, Enhance-ICCI, Enhance-RGB) at the bottom is selected, the adjustment
of definition, brightness, and color will be disabled, and the image is automatically
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processed by the corresponding algorithm.

Click E to undo all the image processing.

5. When the icon of the button next to the time window shows as H, the time window and

the thumbnail time display show image absolute time. Click H, the button icon will change

to B, and the time window and the thumbnail time display will show image relative time.

Click E, and the button icon will change back to H The absolute time is the wall clock

time when the image is captured by the capsule endoscope, the relative time is the time
difference between the image and the first captured image.

4.4.4 Image Tagging

1. Move the mouse over the image to be tagged and right click on the image. In the pop- up

n «

menu (Figure 4-20), select “Select the first esophagus image”, “Select the first stomach
image”, “Select the first small intestine image”, “Select the first large intestine image”, or
“Select the last digestive tract image” to tag the image as a landmark of the digestive tract.
When an image is tagged, the colors in the progress bar will change automatically according
to the position of the tagged image, separating the images by different sites of the digestive
tract. The information in the status bar also changes automatically. The tagged images will

appear in the bottom thumbnail area
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Figure 4-20: Image Tagging
2. Inaddition to tagging an image, the user can also capture an image. Move the mouse over
the image to be captured and right click on the image, then select “Capture image” in the
pop-up menu to capture the image (Figure 4-21). An alternative way to capture an image is
to double click on the image. The captured image will also appear in the bottom thumbnail
area. If the current image is already tagged, such as first esophagus image, the image capture

function is disabled.

Figure 4-21: Image Capture
3. To cancel image tagging or remove an image from the captured image set, click on the image
thumbnail in the thumbnail area to select the image, move the mouse over the image and
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right click on the image then select "Cancel select” in the pop-up menu (Figure 4-22). The
image will be removed from the thumbnail area and the colors in the progress bar will be
updated accordingly.

Figure 4-22: Cancel Image Tagging or Capture

4.4.5 Image Remark

1. Move the mouse over the image you want to add a remark to and right click on the image.

Select “Add remark” in the pop-up menu (Figure 4-23) or click to access the add remark
interface (Figure 4-24).
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Figure 4-23: Add Remark Through
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Figure 4-24: Add Remark Interface
2. Inthe add remark interface, click to add arrow markings. When the icon changes to
u, the user can add an arrow on the image by left clicking to set the start point and holding
the left mouse button and dragging to set the endpoint. Click E to add circular markings.

When the icon changes to EJ, the user can add a circle on the image by left clicking to set
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the center and holding the left mouse button and dragging to change its size (Figure 4-25).

Click to undo the previous marking and click E to undo all markings. The markings

will be reflected on the images in the thumbnail area.

Figure 4-25: Add Markings
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3. Click m to select the first tagged or captured image, click ﬂ to select the previous
tagged or captured image, click ﬂ to select the next tagged or captured image, and click

I:l to select the last tagged or captured image. Alternatively, the user can move the mouse

over an image and scroll over images to select the desired image.

Table 4- 2 Description of buttons in the Add Remark Interface

Button Function Description

Add arrow remark

(*) Add circle remark

L

Add rectangle remark

Measure lesion length

Add text remark

EREEc
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Button Function Description

Set remark color

Remove the previous remark

Remove all remarks

Display the first selected image

Display the previous selected image

Display the next selected image

Display the last selected image

Image Setting

Add text notes

fogdogoanQ

4. Click to access the add comment interface (Figure 4-26). The user can enter textual

descriptions to the image into the comment text box in two ways:

— Input manually; or

— Double click one of the expressions in the “Frequently used comment” list, a built-in list
in ESView software. The user can also add or remove entries in the list.

The added comments will be reflected on the images in the thumbnail area.
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Figure 4-26: Add Remark Interface
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5. As previously described, clicking ﬂ brings up the image processing control panel (Figure

4-27). The sliders and checkboxes function the same as those in the image processing
control panel described previously.

Figure 4-27: Image Processing Control Panel

6. Click g to exit the add remark interface.

4.4.6 Thumbnails

1. Thumbnails of the tagged and captured images are displayed in the thumbnail area, as
shown in Figure 4-28.
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Figure 4-28: Thumbnail Display Area
2. Inthe thumbnail display area, move the mouse over the image to add remark to and right

click on the image, then select “Add remark” in the pop-up menu (Figure 4-29) to add
remark to the corresponding image using the add remark interface shown in Figure 4-26.
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Figure 4-29: Add Remark to Thumbnail

3. Inthe thumbnail display area, right click on a thumbnail, then select “Cancel mark” in the
pop-up menu to remove the thumbnail from the thumbnail area, as shown in Figure 4-30.
Multiple thumbnails can be removed together by left clicking the thumbnails to be deleted

while holding down the Ctrl key or by holding down the left mouse button and dragging the
mouse to select multiple thumbnails, and then right clicking to select “Cancel mark” from the
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pop-up menu.
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Figure 4-30: Thumbnail “Cancel Mark”

4. To go to a specific landmark and display the image in the main display area, in the thumbnail
display area right click on a thumbnail and select “Jump to the first esophagus image”, “Jump

)
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to the first stomach image”, “Jump to the first small intestine image”, “Jump to the first large
intestine image”, or “Jump to the last digestive tract image” in the pop-up menu. Alternatively,
move the mouse over a thumbnail and then double click the left mouse button to display the
corresponding image in the main display area.

4.4.7 Image Processing

1. Clicking B will bring up the image processing control panel (Figure 4-31). The user can
adjust image definition, brightness, and color by using the corresponding sliders.
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Figure 4-31: Image Processing Control Panel

2. ESView software is equipped with image denoise algorithm. Check the “Image denoise” box
and the effect as shown in Figure 4-32. To undo the denoising, uncheck the “Image denoise”
box.

Figure 4-32: Image Denoise

3. Check the “Distortion Correction” box to correct image distortion (Figure 4-33).

ANKON Technologies Co., Ltd. AKQWO-YF-018 RevA/1



NaviCam Small Bowel Capsule Endoscopy System User Manual Page |47

Figure 4-33: Distortion Correction

4. Check the “Enhance - ICCI” box to achieve the post-processing effect (Figure 4-34).

Figure 4 34 Image Enhancement ICCI

5. Check the “Enhance - RGB” box to achieve the post-processing effect (Figure 4-35).
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Figure 4-35: Image Enhancem

6. Use the saturation adjustment sliders to adjust image saturation (Figure 4-36).
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Figure 4-36: Image Saturation Adjustment

7. Use the definition and brightness sliders to adjust the definition and brightness of the image
(Figure 4-37).
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Figure 4-37: Definition and Brightness Adjustment
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4.4.8 Browsing Mode

1. Click E, when the button icon changes to .;, the similarity browsing mode will be

activated (Figure 4-38). In this mode, the software displays only one image for all the
adjacent similar images, reducing number of images to be browsed. Experiments show that
the number of images is reduced by approximately 50%.
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Figure 4-38: Similarity Browsing Mode
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